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Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or
otherwise, without the prior written permission of SEIKO EPSON CORPORATION. The
information contained herein is designed only for use with this EPSON product. EPSON is not
responsible for any use of this information as applied to other equipment.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this
product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties
as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or
alterations to this product, or (excluding the U.S.) failure to strictly comply with SEIKO EPSON
CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the
use of any options or any consumable products other than those designated as Original EPSON
Products or EPSON Approved Products by SEIKO EPSON CORPORATION.

Responsible Use of Copyrighted Materials

Digital cameras, scanners, and ink jet printers, like conventional photocopiers and cameras, can be
misused by improper copying or printing of copyrighted material. While some countries’ laws
permit limited copying of copyrighted material in certain circumstances, those circumstances may
not be as broad as some people assume. EPSON encourages each user to be responsible and
respectful of the copyright laws when using digital cameras, scanners, and ink jet printers.

Trademarks
EPSON is a registered trademark of SEIKO EPSON CORPORATION. EPSON Perfection is a

registered trademark and Easy Photo Fix is a trademark of Epson America, Inc.
DIGITAL ICE is a trademark of Kodak.

General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. EPSON disclaims any and all rights in those marks.
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Scanner Features

Whether you are scanning a recent photo or a faded photo from the past, your
EPSON® Perfection® 4870 scanner includes these features so you can get the best
possible scan:

m  DIGITAL ICE™ Technology
m  Easy Photo Fix™

These features are described below. For -

instructions on using these features, see “Scanning and
Restoring Photos” on page 5 and “Scanning Film” on page 6.
You can also scan pages of type and turn them into editable
text as described on page 10.

DIGITAL ICE Technology

Your scanner includes both DIGITAL ICE Technology for Photo Prints and for
Film. The DIGITAL ICE (Image Correction and Enhancement) technology is
built into the Perfection 4870 scanner and works along with the included
DIGITAL ICE software. This combination of hardware and software lets you
scan, correct, and restore your photos in one easy step, without any compromise in
image quality.

With DIGITAL ICE for Photo Prints, your scanner examines your photo for
defects on the surface, such as scratches, tears, cracks, and dust. It does this by
shining a second light source on your photo and storing information about the
shadows these defects create in a separate data space. It then uses this information
to remove the defects from your scanned image so you don’t have to remove them
yourself.

DIGITAL ICE for Film uses a different method to automatically remove
scratches, dust, and fingerprints from your scanned image. During the typical
scanning process, information is gathered using red, green, and blue channels.
With DIGITAL ICE for Film, an additional infrared channel collects the defect

information for correction.

The results are truly amazing. Though it takes a bit longer to scan with DIGITAL
ICE Technology, the end results will save you time. The majority of the
painstaking work of removing scanned defects is done for you. Final touch-ups
can still be done in Photoshop®
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Here are some examples of scan times with and without DIGITAL ICE

Technology over a FireWire® connection. Your scan times may vary, depending on

your computer system and connection.

Scan time without Scan time with
DIGITAL ICE DIGITAL ICE
Original photo Resolution | Technology Technology
4 x 6 photo 300 10 seconds 1 minute, 40 seconds
35mm slide 2400 1 minute 8 minutes, 22 seconds
35mm negative 2400 1 minute, 30 seconds | 10 minutes, 20 seconds

Note:
When using DIGITAL ICE Technology to scan printed photos, select a resolution
between 50 and 1200 dpi. Note that DIGITAL ICE Technology does not detect tape or

fingerprints or marks from pens or markers because these appear as part of the image
and not as surface defects. DIGITAL ICE Technology should not be used to scan printed

items like magazines.

DIGITAL ICE Technology supports color and chromogenic (dye-based) black and white

film. For best results, do not use with conventional black and white negative film or
Kodachrome™ film.

EPSON Easy Photo Fix

With just one click, you can use Easy Photo Fix to restore the color of faded

photos, negatives, and slides; remove dust from slides and negatives; or reduce film

grain in your scans. The three elements of Easy Photo Fix are described below:

m  Color Restoration

Restores faded photographs, slides, and negatives. Removes the blue hue from

underwater photos.

s Dust Removal

Removes dust from slides and negatives, including black and white negative
film and Kodachrome film.

m  Grain Reduction
Reduces the grain pattern on film. Use when scanning high-speed film or
underexposed images in Professional Mode.
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Scanning and Restoring Photos

Selecting Software Settings in EPSON Scan

The following example uses Adobe® Photoshop Elements 2.0 and EPSON Scan.
If you are using another software application, your steps may be different.

1.

Start Adobe Photoshop Elements:

In Windows?® click Start > Programs or All Programs >

Adobe Photoshop Elements 2.0.

On a Macintosh® open the Adobe Photoshop Elements 2 folder (in your
Applications folder) and double-click the Photoshop Elements 2.0 icon.

Select File > Import > EPSON Perfection 4870.

In EPSON Scan, choose Home or
Professional mode. You see a screen
similar to this:

Click the Preview button at the
bottom of the screen. Your photo
appears in the Preview window.

Click the [z button to select the
image area to be scanned. Adjust the
marquee if necessary.

Do one of the following:

m  Ifyou're using Home Mode, click
the Image Adjustments button.

m  Ifyou're using Professional Mode,

scroll to the bottom of the screen.

Select the Digital ICE or Color
Restoration checkbox:

la” EPSON Scan

BEE

£ EPSON Scan - EPSON Perfection 4870
Mode:

Home Mode w
Document Tupe
'#',/ Phato -
Image Type
(%) Color () Grayscale () Blacktwhite
Destination
O Screen/web (&) Printer O Other

Target Size:

Image Adjustments.. |

[ Auto preview

b fu -

o]

[ Canfiguration... ] [ Close ]

™ Color Restaration
-
I Digital ICE([TH)]

m  Ifyour photo is dirty, scratched, creased, or torn,

select Digital ICE.

m  If the colors in your photo are faded, select Color Restoration.

Note:

You can select both settings, if necessary.
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8. Click the Scan button.

After your photo is scanned, you can make more adjustments in Photoshop
Elements or save your file.

Scanning Film

Your scanner includes four film holders. Each film holder allows you to scan
multiple images at once. You can scan up to twenty-four 35mm filmstrip images,
eight 35mm slides, three 120/220 (6 x 12 cm) film images, or two 4 x 5 film
images.

Using the Film Holders

To scan film, you'll need to remove the reflective document mat and place the film
in a holder.

1. Make sure the transparency unit cable is connected to the option interface
connector on the back of the scanner. (If it is not connected, turn off the
scanner, connect the transparency unit cable, then turn the scanner back on.)

2. Lift the scanner lid all the way up and pull
the reflective document mat up and off of
the scanner lid, as shown.
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3. Ifyou are scanning film or negatives, open the cover, then slide the film into
the corresponding holder, with the film’s base side facing down. (If you are
scanning slides, go to step 6.)

4. Lock the film holder cover into place.

5. DPlace the film holder on the scanner as shown. Make sure the white triangle
on the holder points to the upper-right corner of the scanner.

Make sure the
calibration space at
the top is uncovered
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6. If you are scanning slides, place the holder on the scanner. Then place the

slides in the holder.

Make sure the
calibration space
at the top

is uncovered

7. Close the scanner cover.

Selecting Software Settings in EPSON Scan
The following example uses Adobe Photoshop Elements 2.0 and EPSON Scan. If

you are using another software application, your steps may be different.
1. Start Adobe Photoshop Elements:

In Windows, click Start > Programs or All Programs >
Adobe Photoshop Elements 2.0.

On a Macintosh, open the Adobe Photoshop Elements 2 folder (in your
Applications folder) and double-click the Photoshop Elements 2.0 icon.

2. Select File > Import > EPSON Perfection 4870.

3. In Home Mode, select Document Type
Positive Film (for slides) or ‘1 S J
Color Negative Film (for negatives)
as the Document Type, then click
the Scan button.

In Professional Mode, select Film as Ot

the Document Type; then select a Document Tipe: [Fim =
Film Type: Positive (for slides), or Fim Typs [Color Negative Film =
Color Negative Film or B&W

Negative Film (for negatives). Click

the Scan button.
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4. Do one of the following:
m  Ifyou're using Home Mode, click the Image Adjustments button.
m  Ifyou're using Professional Mode, scroll to the bottom of the screen.

5. Click the Preview button at the

bottom of the screen. b Fusie |

Frame

Thumbnails of your images appear in

the Preview window:

6. Click the All button to adjust all the a
images at once or select a thumbnail
to adjust each image individually.

v 5

Help |

<o81in £1.220m. 1200 » 1800 pixels €.17 ME RGB!

7. Select from the following Image Adjustment options: G asin Reduction

™ Color Restaration

m  Grain Reduction (available only in Professional
mode). Use with high-speed film or
underexposed images. Select the level of grain

reduction by clicking the button.

m  Color Restoration. Restores color to faded images.

[~ Dust Bemaval
I Digital ICE(TH)

m  Dust Removal. Removes dust. Select the level of dust removal by

clicking the button.

m Digital ICE. Removes scratches, dust, and fingerprints.

Note:
You cannot select Dust Removal and Digital ICE at the same time.

8. Click the Scan button.

After your images are scanned, you can make more adjustments in Photoshop
Elements or save your files.
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Scanning Text

If you have a page of text that you don’t want to retype, you can save time by
scanning it using ABBYY® FineReader® Sprint to get an editable page of text.

Follow these steps:
1. Place your text page face down on the scanner glass and close the cover.
2. Start ABBYY FineReader Sprint:

In Windows, click Start > Programs or All Programs >
ABBYY FineReader 5.0 Sprint.

On a Macintosh, open the ABBYY FineReader 5 Sprint Plus folder (in your
Applications folder) and double-click the Launch FineReader 5 Sprint

icon.

5 . .
3. Ifyou're using Macintosh OS 8.6 to 9.x, Update TWAIN Source Manager
¥i i N TwWalIN Source Manager installed on your computer is

you sec thiS message thC ﬁrSt time incompatible with current version of ABBYY FineReader
. . . Sprint. This update dossn't sffect the previous TWaIN
ABBYY FlneReader 1S launched. Clle Ssurcebf:aﬂaqepr version in anyway;\plwl\sh” be
accessble.
Install TWAIN 1.8.

['cancel ] |[ nstan TWAIN 1.8 ||

4. If you're using Macintosh, choose Select Scanner from the Scan&Read
menu. Select EPSON Perfection 4870 as your scanner, then click OK.

5. Click the 13 Scan button. EPSON Scan starts.

In Full Auto Mode, your document is automatically scanned.

In Home Mode, select Text/Line Art  Bocunent Tune

as the Document Type, then click the ‘ - / TortLine At j
Scan button. (If the Scan button is

grayed out, click the Preview

button. After your document is

previewed, click Scan.)

In Professional Mode, select B

Reflective as the Document Type syt s [Feflective =]
and Black & White as the Image Beaye Gaee [ Document Tble El
Type, then click the Scan button. Auko Exposure Type: [Decument =
Note: Destination

If you're in Home or Professional Mode, Image Type:
select a resolution of 200 to 600 dpi.
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6. When EPSON Scan is finished, click the 2[

& Read button.

7. When file reading is finished, click the *E#& Save button.

8.

Select a location and file name, then click Save.

You now have a text file that you can edit.

For more information, see the ABBYY FineReader Sprint User’s Guide or Help:

In Windows, click Start > All Programs or Programs > ABBYY
FineReader Tools > ABBYY FineReader 5.0 Sprint User’s Guide

In Macintosh, select Help from the menu bar in the ABBYY FineReader

program.

Tips and Troubleshooting

Do not create a marquee (image area to be scanned) larger than your photo.

Otherwise DIGITAL ICE Technology may mistake the edges of your photo as

If DIGITAL ICE Technology doesn’t correct the tear or wrinkle in your
photo, place the photo at a slight angle and scan it again. You could also try

Tips for Best Results
m  Make sure your photo is as flat as possible.
|
defects.
n
placing your photo in the opposite orientation (landscape or portrait).
|

DIGITAL ICE Technology requires more system resources than regular
scanning. If you get an error message, you may need to clear some hard drive

space.

Do not include the film holder when creating a marquee. If the scanning
region includes the frame holder edges, the image may not be accurately

analyzed and corrected.

Make sure the calibration space on the film holder is clean and uncovered.

If you set the Grain Reduction level to High, you may reduce the sharpness

of your image.
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m  Ifyou have dust on your film, you can use the Dust Removal setting instead
of the Digital ICE setting for faster scanning.

m  In Full Auto Mode, you can let the software automatically set the scanning
resolution (dpi) for your scan or you can set the resolution yourself. For even
more options, use Home or Professional Mode instead.

Saving Custom Settings

If there are certain settings you use often—for example, you need to scan images in
grayscale at 300 dpi—you can create your own custom settings and recall them at
any time.

Follow these steps to create custom settings:
1. Start EPSON Scan and select Professional Mode.
2. Select your settings.

3. In the Settings box, type a Name for your settings, then click the Save

button.
& EPSON Scan - EPSON Perfection 4870 LE&
: Mode:
b EPSON Scan Professional Mode v
Settings
Mame: Grayzcale 300 dpi w

Save

Tip:
To make it easier to remember your custom settings, use a name that describes the
type of scan or settings.

The next time you need to scan with the same settings, simply select your custom
settings from the Name box. You can save up to 30 custom settings.
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Using EPSON Scan for Quick Scanning

For quick scans, you can use EPSON Scan in stand-alone mode. You can start
EPSON Scan by pressing the < Start button or start it from your computer, as
follows:

m  Windows: Click Start > Programs or All Programs > EPSON Scan >
EPSON Scan.

m  Mac OS X: Double-click the EPSON Scan icon in the Applications folder.
m  Mac OS 8.6 to 9.x: Select EPSON Scan from the Apple® menu.

You see the screen below. After selecting your settings, EPSON Scan launches and
scans your image.

£ File Save Settings g|

Locati i
ocation Select a location

C:A\Documents and Settingshepsonity Document — to save your file

File Mame [Prefix + 3-digit number]

Erefis: img Start Number: o 5
N
ame _ |
your file Image Farmat
Tupe: EITMAP [*.bmp) v

L | Chooseafile type

D etails:

[ Owenwrite any filez with the same name
Show thiz dialog box before nest scan
Open image folder after scanning

Click OK _ 0Ok ] [ Cancel ] [ Help
to scan

Note:

If you're using Windows, you can assign other applications (for example, Photoshop
Elements or ABBYY FineReader) to the < Start button. When you press the < Start
button, EPSON Scan'’s dialog box opens, or scanning starts automatically and the
scanned image is opened in the application. See your on-screen Reference Guide for
instructions.
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Troubleshooting

Problem

Solution

You see an error message
when you try to scan, or
the scanner doesn’t scan.

Make sure the scanner is connected to your
computer, plugged into a power source, and the
scanner is turned on.

Turn the scanner off and then back on to reset it.

Make sure both transportation locks are unlocked.

The corner of your photo
is not scanned.

Move your photo at least 0.06 inch (1.5 mm) away
from the top and right edge of the document table.

You can't scan negatives or

slides.

Make sure the transparency unit cable is connected
to the scanner and the reflective document mat is
removed. If the transparency unit cable is not
connected, turn off the scanner, connect the cable,
and turn the scanner back on.

Try using Home or Professional Mode instead of
Full Auto Mode. Make sure the Document Type or
Film Type matches what you're scanning; either
Color Negative Film, B&W Negative Film, or
Positive Film (for slides and transparencies).

Also, make sure the scanner glass is clean and the
film holder is positioned correctly.

You're using the
transparency unit, and the
colors of your negative film
preview look strange.

Make sure you've selected the correct Document
Type/Film Type in EPSON Scan.

If your film is not faded, make sure the Color
Restoration option is not selected.

You see light vertical lines
on the scanned image.

The calibration space (the small rectangle of glass
at the top the document glass) may contain dirt or
dust. Clean the calibration space with a lint-free

cloth.

For additional troubleshooting help, see your electronic Reference Guide.
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Notices

Important Safety Instructions

Read all of these instructions and save them for later reference. Follow all warnings and

instructions marked on the scanner.

Place the scanner close enough to the computer for the interface cable to reach it
easily. Do not place or store the scanner outdoors, on an unstable surface, near
excessive dirt or dust, water, heat sources, or in locations subject to shocks, vibrations,
high temperature or humidity, direct sunlight, strong light sources, or rapid changes
in temperature or humidity. Do not use with wet hands.

Place the scanner near an electrical outlet where the power cord can be easily

unplugged.

Allow space behind the scanner for the cables, and space above the scanner so that you
can raise the document cover fully.

Unplug the scanner before cleaning. Clean with a damp cloth only. Do not use liquid
or aerosol cleaners.

Keep the scanner out of the reach of children.
Use only the type of power source indicated on the scanner’s label.

Power-supply cords should be protected from abrasion, cuts, crimping, and kinking.
Be sure to place your cords to avoid any damage. Do not place objects on top of the
power cord or allow the power cord to be stepped on or run over. Be particularly
careful to keep all power-supply cords straight at the ends and at the points where
they enter and leave the transformer.

Connect all equipment to properly grounded power outlets. Avoid using outlets on
the same circuit as photocopiers or air control systems that regularly switch on and

off.
Do not let the power cord become damaged or frayed.

If you use an extension cord with the scanner, make sure the total ampere rating of
the devices plugged into the extension cord does not exceed the cord’s ampere rating.
Also, make sure the total ampere rating of all devices plugged into the wall outlet does
not exceed the wall outlet’s ampere rating. Do not place multiple loads on the
electrical outlet.

Never disassemble, modify, or attempt to repair the scanner, integrated TPU, or
power cord.

Do not insert objects into any openings as they may touch dangerous voltage points
or short out parts. Beware of electrical shock hazards.

Notices
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m  This product includes a lamp that contains mercury. Please consult your state/
province and local regulations regarding disposal or recycling. Do not put it in the
trash.

m  Ifyou are not going to use the scanner for a long period, be sure to unplug it from the
electrical outlet.

m  Unplug the scanner and refer servicing to qualified service personnel under the
following conditions:

If the power cord or plug is damaged; if liquid has entered the scanner; if the scanner
has been dropped or the case damaged; if the scanner does not operate normally or
exhibits a distinct change in performance. (Do not adjust controls that are not
covered by the operating instructions.)

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio or
television reception. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

m  Reorient or relocate the receiving antenna.
m  Increase the separation between the equipment and receiver.

m  Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

m  Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this
equipment will invalidate the FCC Certification of this device and may cause interference
levels which exceed the limits established by the FCC for this equipment. It is the
responsibility of the user to obtain and use a shielded equipment interface cable with this
device. If this equipment has more than one interface connector, do not leave cables
connected to unused interfaces. Changes or modifications not expressly approved by the
manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulations.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/
or CPU Boards and Power Supplies used with Class B Personal Computers:

We: EPSON America, Inc.
Located at: MS 3-13
3840 Kilroy Airport Way

Long Beach, CA 90806-2469
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR
Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed, is
identical to the representative unit tested and found to be compliant with the standards.
Records maintained continue to reflect the equipment being produced can be expected to
be within the variation accepted, due to quantity production and testing on a statistical
basis as required by 47CFR §2.909. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

Trade Name: EPSON
Type of Product: Image Scanner
Model: J131A

Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“EPSON”) warrants to the original retail purchaser
of the EPSON product enclosed with this limited warranty statement, that the product if
purchased new and used in the United States or Canada, conforms to the manufacturer’s
specifications and will be free from defects in workmanship and materials for a period of
one (1) year from the date of original purchase. For warranty service, you must provide
proof of the date of original purchase.

What EPSON Will Do To Correct Problems: Should your EPSON product prove defective
during the warranty period, please bring the product securely packaged in its original
container or an equivalent, along with proof of the date of original purchase, to your
EPSON Dealer or EPSON Customer Care Center. You are responsible for all costs
(shipping, insurance, travel time) in getting the product to the service location. EPSON
will, at its option, repair or replace on an exchange basis the defective unit, without charge
for parts or labor. When warranty service involves the exchange of the product or of a part,
the item replaced becomes EPSON property. The replacement unit may be new or
refurbished to the Epson standard of quality, and at Epson’s option, the replacement may
be another model of like kind and quality. Epson’s liability for replacement of the covered
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product will not exceed the original retail selling price of the covered product. Exchange or
replacement products or parts assume the remaining warranty period of the product
covered by this limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or
reconditioned products. This warranty covers only normal use in the United States and
Canada. This warranty does not cover damage to the EPSON product caused by parts or
supplies not manufactured, distributed or certified by EPSON. This warranty is not
transferable. This warranty does not cover third party parts, components or peripheral
devices added to the EPSON product after its shipment from EPSON, e.g., dealer-added
boards, chips or drives. EPSON is not responsible for warranty service should the EPSON
label or logo or the rating label or serial number be removed or should the product fail to
be properly maintained or fail to function properly as a result of misuse, abuse, improper
installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and
lightning, improper electrical current, software problems, interaction with non-EPSON
products, or service other than by an EPSON Authorized Servicer. If a claimed defect
cannot be identified or reproduced in service, you will be held responsible for costs
incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN
LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL
EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY
PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS
OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE
VOID. IN THE EVENT THE REMEDIES ABOVE FAIL, EPSON’S ENTIRE
LIABILITY SHALL BE LIMITED TO A REFUND OF THE PRICE PAID FOR THE
EPSON PRODUCT COVERED BY THIS LIMITED WARRANTY. EXCEPT AS
PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA,
INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS,
INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE
USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING
FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts and
some jurisdictions do not allow certain exclusions or limitations on damages, so the above
limitations and exclusions may not apply to you. This warranty gives you specific legal
rights, and you may also have other rights which vary from jurisdiction to jurisdiction.

To locate the EPSON Authorized Reseller or EPSON Customer Care Center nearest you
call (800) 922-8911 or write to: Epson America, Inc., P.O. Box 93012, Long Beach, CA
90809-3012.
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Fonctions du scanner

Que ce soit pour la numérisation d’une photo récente ou d’une vielle photo
décolorée, le scanner EPSON® Perfection® 4870 offre les fonctions suivantes pour
produire les meilleures numérisations possibles :

m  Technologie DIGITAL ICE™®
m  Easy Photo Fix"¢

Ces fonctions sont décrites ci-dessous.
Pour des instructions sur lutilisation de =

ces fonctions, voyez « Numérisation et restauration de

photos » a la page 21 et « Numérisation de films » a la page 23.
Vous pouvez également numériser des pages de texte et les
convertir en texte modifiable, tel que décrit a la page 27.

Technologie DIGITAL ICE

Votre scanner offre la technologie DIGITAL ICE pour tirages photo et pour films.
La technologie DIGITAL ICE (Image Correction and Enhancement [Correction
et amélioration de I'image]) est intégrée au scanner Perfection 4870 et travaille de
concert avec le logiciel DIGITAL ICE fourni avec 'appareil. Cet ensemble
matériel-logiciel vous permet de numériser, de corriger et de restaurer vos photos
en une seule étape, sans compromettre la qualité d’image.

Avec DIGITAL ICE pour tirages photo, votre scanner examine votre photo afin de
détecter les défauts de surface, notamment les égratignures, les déchirures, les
craquelures et la poussiere. Pour ce faire, votre scanner effectue une seconde
numérisation de votre photo et enregistre dans un espace données distinct des
informations sur les ombres créées par les défauts. Ces renseignements sont ensuite
utilisés pour supprimer les défauts de I'image numérisée de sorte que vous n’ayez
pas a le faire vous méme.

DIGITAL ICE pour films utilise une méthode différente pour supprimer
automatiquement les égratignures, la poussiere et les traces de doigt de I'image
numérisée. Pendant le processus de numérisation type, des renseignements sont
recueillis aux moyen de canaux rouges, verts et bleus. Avec DIGITAL ICE pour
films, un canal infrarouge supplémentaire identifie les défauts afin de les corriger.

Fonctions du scanner
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Les résultats sont extraordinaires. Bien que la technologie DIGITAL ICE ralentisse
quelque peu la numérisation, les résultats obtenus vous permettront d’épargner du
temps. Comme les défauts sont supprimés au moment de la numérisation, les
besoins d’édition photo sont réduits de fagon considérable. Les derniéres retouches
peuvent toujours étre faites dans Photoshop®

Voici quelques exemples du temps requis pour numériser une image avec ou sans
technologie DIGITAL ICE (au moyen d’une connexion FireWire®) Le temps de

numérisation peut varier selon 'ordinateur et la connexion utilisée.

Temps de Temps de
numeérisation numérisation
sans technologie avec technologie
Photo d’origine Résolution | DIGITAL ICE DIGITAL ICE
Photo 4 x 6 po 300 10 secondes 1 minute, 40 secondes
Diapositive 35 mm | 2 400 1 minute 8 minutes, 22 secondes
Négatif 35 mm 2 400 1 minute, 30 secondes | 10 minutes, 20 secondes

Remarque :

Vous devez sélectionner une résolution de numérisation entre 50 et 1 200 ppp lorsque
vous utilisez la technologie DIGITAL ICE. Il convient de noter que la technologie
DIGITAL ICE ne détecte pas les rubans, les traces de doigt et les marques de crayons
et de marqueurs car ceux-ci paraissent intégrés a l'image et ne sont pas interprétés
comme étant des défauts de surface. DIGITAL ICE ne doit pas étre utilisé pour la
numeérisation de documents imprimés comme les magazines.

La technologie DIGITAL ICE pour films prend en charge les bandes de film couleur et de
film noir et blanc chromogéne (a base de colorant). Pour obtenir des résultats
supérieurs, n'utilisez pas de film Kodachrome™® ou de négatifs noir et blanc
conventionnels.

EPSON Easy Photo Fix

En un seul clic, la technologie Easy Photo Fix vous permet de restaurer la couleur
des photos, diapositives et négatifs décolorés, de supprimer la poussiere des
diapositives et négatifs et de réduire I'aspect granuleux des images numérisées. Easy
Photo Fix offre les trois fonctions suivantes :

m  Restauration de la couleur
Permet de restaurer les photographies, diapositives et négatifs décolorés.
Permet aussi de supprimer les tons bleus des photos prises sous I'eau.
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m  Dépoussiérage
Permet de supprimer la poussiere des diapositives et négatifs, y compris les
films Kodachrome et les négatifs noir et blanc.

m  Réduction du grain
Réduit I'aspect granuleux des films. Convient a la numérisation en mode
Professionnel de films & émulsion ultra-rapide et d’images sous-exposées.

Numérisation et restauration de photos

Sélection des parametres dans EPSON Scan

Lexemple suivant porte sur les applications Adobe® Photoshop Elements 2.0 et
EPSON Scan. Si vous utilisez une autre application, les étapes peuvent étre
différentes.

1. Lancez Adobe Photoshop Elements :

Dans Windows® cliquez sur Démarrer > Programmes ou Tous les
programmes > Adobe Photoshop Elements 2.0.

Sur un ordinateur Macintosh® ouvrez le dossier Adobe Photoshop
Elements 2 (dans le dossier Applications) et double-cliquez sur I'icone
Photoshop Elements 2.0.

2. Sélectionnez Fichier > Importation > EPSON Perfection 4870.
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3. Dans EPSON Scan, sélectionnez le mode [y AE]

1c1 M 4 Mode:
Loisirs ou Professionnel. Un écran ki EPSONScan o —
semblable a celui s'affiche : T
. . B o j
4. Cliquez sur le bouton Apercu situé au bas ‘ &/
de I'écran. Votre photo saffiche dans la Ty dinage :
@ By ® emedsas  Mair & Blanc
fenétre Apercu.
. ® By (Q [t ® ek
5. Cliquez sur le bouton ]

sélectionner la zone d’image a4 numériser. Fndctlzl  Joma 3
Ajustez au besoin le rectangle de sélection.
Bt e iz

[ Apercu auto

6. Effectuez une des étapes suivantes :

m  Lorsque vous utilisez le mode Loisirs, }
cliquez sur le bouton Ajustements
de |'image. AideH) ‘ Configuration... ‘ Fermer(C) ‘

| L] e ) Nemére

m  Pour le mode Professionnel, défilez
jusqu’au bas de I'écran.

7. Cochez la case Digital ICE ou Restauration de la
couleur :

I Restauration de la coulsur

I~
m  Sila photo comporte des souillures, des [ Digital ICE{TH]
égratignures, des plis ou des déchirures,
sélectionnez Digital ICE.

m  Siles couleurs sont décolorées, sélectionnez Restauration de la couleur.

Remarque :
Sélectionnez les deux options au besoin.

8. Cliquez sur le bouton Numériser.

Une fois la photo numérisée, il est possible d’effectuer d’autres réglages dans
Photoshop Elements ou de sauvegarder le fichier.
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Numeérisation de films

Le scanner est livré avec quatre supports pour bandes de film. Chaque support
permet de numériser simultanément plusieurs images. Il est possible de numériser
jusqu’a 24 images de bande de film de 35 mm, huit diapositives de 35 mm, trois
négatifs de 120/220 (6 x 12 cm) ou deux négatifs de 4 x 5 po (10,2 x 12,7 cm).

Utilisation des supports de films

Pour numériser dCS ﬁlms, vous dCVCZ retirer le cache our docurnents opaques ct
q
placer la bande de ﬁlm dans un support.

1. Assurez-vous que le cible du lecteur de transparents est bien fixé au
connecteur de I'interface en option. (Sinon, mettez le scanner hors tension,
branchez le cible du lecteur de transparents et remettez le scanner sous
tension.)

2. Ouvrez le couvercle du scanner et
retirez le cache pour documents
opaques, tel qu'illustré.
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3. Sivous numérisez des bandes de film ou des négatifs, ouvrez le couvercle du
support, placez la bande de film dans le support approprié, co6té support du
film vers le bas. (Si vous numérisez des diapositives, passez a I'étape 6.)

4. Verrouillez le couvercle du support de films.

5. Placez le support de films sur le scanner, tel qu'illustré. Assurez-vous que le
triangle blanc du support est orienté vers le coin supérieur droit du scanner.

Assurez-vous de
ne pas couvrir la
zone d'étalonnage.

Numeérisation de films



6. Sivous numérisez des diapositives, placez le support sur le scanner. Placez
ensuite les diapositives dans le support.

Assurez-vous de
ne pas couvrir la
zone d'étalonnage.

7. Fermez le capot du scanner.

Sélection des parametres dans EPSON Scan

Lexemple suivant porte sur les applications Adobe Photoshop Elements 2.0 et
EPSON Scan. Si vous utilisez une autre application, les étapes peuvent étre
différentes.

1. Lancez Adobe Photoshop Elements :

Dans Windows, cliquez sur Démarrer > Programmes ou Tous les
programmes > Adobe Photoshop Elements 2.0.

Sur un ordinateur Macintosh, ouvrez le dossier Adobe Photoshop
Elements 2 (dans le dossier Applications) et double-cliquez sur I'icone
Photoshop Elements 2.0.

2. En mode Loisirs, sélectionnez Film Type de document

positif couleur (pour les ‘1 Film négatil couleu j

diapositives) ou Film négatif
couleur (pour les négatifs) comme
parametre Type de document, puis cliquez sur le bouton Numériser.

En mode Professionnel, sélectionnez Driginal
Film comme pafamétre Type de Type de document: Film j
document; sélectionnez ensuite le - Fim négalif coulew

Type de film : Film positif couleur
(pour les diapositives), Film négatif couleur ou Film négatif monochrome
(pour les négatifs). Cliquez sur le bouton Numériser.
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3. Effectuez I'une des étapes suivantes :

m  Sivous utilisez le mode Loisirs, cliquez sur le bouton Ajustements de
I'image.

m  Pour le mode Professionnel, défilez jusqu’au bas de I'écran.

4. Cliquez sur le bouton Apergu situé au & apergu BE]
bas de Iécran. SR
E|EE
Des reproductions miniatures de vos m’"
=
images s affichent dans la fenétre Apergu. |~
5. Cliquez sur le bouton Toutes pour )
ajuster toutes les images en méme temps
ou sélectionnez une miniature pour
ajuster une seule image 2 la fois.
— T
35,7 mm 3 23.8 mm 1800 x 1300 prosks 617 Mo ViR
6. Sélectionnez parmi les réglages suivants : " Béduction du grai(E]
m  Réduction du grain (offert uniquement en B (et st
mode Professionnel). Utilisez avec les films a [ Dépoussigage

, . . ;i [ Digital ICE(TH)
émulsion ultra-rapide ou avec les images sous-

exposées. Sélectionnez le niveau de réduction de grain en cliquant sur le

bouton .
m Restauration de la couleur. Rétablit les couleurs des images décolorées.

m  Dépoussiérage. Supprime la poussiére. Sélectionnez le niveau de
réduction de la poussi¢re en cliquant sur le bouton .

m Digital ICE. Supprime les égratignures, la poussi¢re et les traces de doigt.

Remarque :

Il n"est pas possible de sélectionner simultanément les options Dépoussiérage et
Digital ICE.

7. Cliquez sur le bouton Numériser.

Une fois les images numérisées, il est possible d’effectuer d’autres réglages dans
Photoshop Elements ou de sauvegarder les fichiers.
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Numeérisation de texte

Lorsque vous ne désirez pas retaper une page de texte, gagnez du temps en
numérisant la page en utilisant 'application ABBYY® FineReader® Sprint pour
obtenir une page de texte pouvant étre modifiée.

Suivez les étapes ci-apres :

1.

3. Cliquez sur le bouton 13

Placez la page de texte face vers le bas sur la vitre d’exposition du scanner et
fermez le capot.

Lancez ABBYY FineReader Sprint :

Dans Windows, cliquez sur Démarrer > Programmes ou Tous les
programmes > ABBYY FineReader 5.0 Sprint.

Sur un ordinateur Macintosh, ouvrez le dossier ABBYY FineReader 5 Sprint
Plus (dans le dossier Applications) et double-cliquez sur 'icone Launch

FineReader 5 Sprint [E3.
A Mettre a jour le Gestionnaire de Sources

m  Sivous utilisez Macintosh OS 8.6 4 9.x,
le message suivant s'affiche la premiére R s bt

. A ordinateur n'est pas compatible avec la version actuelle de
ABBYY FineReader Sprint. Cette mise a jour n'affects pas
fois que vous lancez ABBYY FineReader. e e

. qui resters acsessible
CllqueZ sur |nSta||eZ TWAIN 1.8.

Si vous utilisez un Macintosh, choisissez
Sélectionner le scanner depuis le menu Numériser&Lire.
Sélectionnez le scanner EPSON Perfection 4870, puis cliquez sur OK.

m  Sous Macintosh OS X, la version anglaise I’ EPSON Scan est lancée. Pour
utiliser la version frangaise ’ EPSON Scan, procédez comme suit :

Lancez EPSON Scan comme application autonome et numérisez votre
texte en utilisant les parametres désirés. Enregistrez la page de texte
numérisée sous forme de fichier . TIE Ouvrez ensuite le fichier .- TIF dans
ABBYY FineReader en sélectionnant 'option Ouvrir&Lire. Passez ensuite
a I'étape 7 ci-dessous.

ial Numériser. EPSON Scan est lancé.
En mode Auto, le document est automatiquement numérisé.

En mode Loisirs, sélectionnez Texte/ U £ Szl

Mode trait comme Type de o] T j
document, puis cliquez sur le bouton

Numeériser. (Si le bouton Numériser est estompé, cliquez sur le bouton
Apercu. Une fois la prénumérisation terminée, cliquez sur Numériser.)

Numérisation de texte
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En mode Professionnel, sélectionnez
Opaque comme parametre Type de
document et Noir & Blanc comme
parametre Type d’image, puis cliquez
sur le bouton Numériser.

Original

Type de document: |E|Daque

E
Source du document: |Vltle dexposition j
Option dAuta Exposition: |Dncument j

Destination

Remarque H Type dimage: M M
Lorsque vous numérisez en mode
Loisirs ou Professionnel, sélectionnez une résolution entre 200 et 600 ppp.

4. Quand EPSON Scan a terminé la numérisation, cliquez sur Lire 2 [

5. Une fois la lecture du fichier terminée, cliquez sur Enregistrer 3 =N

6. Sélectionnez un emplacement et un nom de fichier, puis cliquez sur
Enregistrer.

Vous pouvez maintenant modifier le fichier texte de la page numérisée.

Pour plus d’information, consultez I'aide en ligne ou le guide de l'utilisateur de
application ABBYY FineReader Sprint :

m  Windows : Cliquez sur Démarrer > Tous les programmes ou
Programmes > ABBYY FineReader Tools > Guide de I'utilisateur
d’ABBYY FineReader 5.0 Sprint.

®m  Macintosh : Sélectionnez Aide depuis la barre de menus dans 'application
ABBYY FineReader.

Astuces et résolution de problemes

Astuces pour obtenir les meilleurs résultats

m  Assurez-vous de placer vos photos bien a plat sur la vitre d’exposition.

m  Ne créez pas de rectangle de sélection plus grand que la photo, car la
technologie DIGITAL ICE peut interpréter les bords de celle-ci comme étant
des défauts de surface.

m  Lorsque la technologie DIGITAL ICE ne supprime pas les plis et les
déchirures d’une photo, pivotez légerement la photo sur la vitre d’exposition
puis effectuez de nouveau la numérisation. Ou encore, modifiez I'orientation
(paysage ou portrait) de la photo.
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La technologie DIGITAL ICE nécessite plus de ressources systtme qu'une
numérisation ordinaire. Si un message d’erreur s’affiche, il est possible que
vous deviez faire de 'espace supplémentaire sur le disque dur de 'ordinateur.

Ne sélectionnez pas le support de films lorsque vous créez un rectangle de
sélection. Lorsque la zone de numérisation inclut les bords du support de
films, I'analyse et la correction de I'image peuvent ne pas étre effectuées
correctement.

Assurez-vous que la zone d’étalonnage du support de films est propre et non
couverte.

Lorsque le parametre Réduction du grain est défini sur Fort, une réduction
de la netteté de I'image peut se produire.

Lorsque le film comporte de la poussiere, utilisez le parametre
Dépoussiérage plutdt que Digital ICE pour accélérer la numérisation.

En mode Auto, vous pouvez laisser au logiciel le soin de sélectionner
automatiquement la résolution de numérisation ou effectuer le réglage vous-
méme. Pour encore plus d’options, utilisez les modes Loisirs ou Professionnel.

Enregistrement de paramétres personnalisés

Lorsque vous utilisez souvent certains parametres — par exemple, numérisation
d’images en niveaux de gris 300 ppp — il est possible de créer des parametres
personnalisés et de les sélectionner au besoin.

Suivez les étapes ci-apres pour créer des parametres personnalisés :

1.
2.

Lancez EPSON Scan et sélectionnez Mode professionnel.
Sélectionnez les parametres désirés.

Dans la zone Parametre, entrez un nom pour vos parametres dans la liste
déroulante Nom, puis cliquez sur le bouton Enregistrer.

& EPSON|Scan- EPSON Perfection 4870 A=L3
Mode:
b EPSON Scam Mode profeszionnel w
Faramétre
Moml): Miveaus de gris 300 ppp w

Astuces et résolution de problemes
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Astuce :

Afin de simplifier la sélection de vos parametres personnalisés, attribuez-leur un nom
qui décrit bien le type de numérisation ou les parameétres.

La prochaine fois que vous effectuerez une numérisation, il suffira de sélectionner
le nom attribué a ces parametres dans la liste déroulante Nom. Vous pouvez
enregistrer jusqu'a 30 groupes de paramétres personnalisés.

Numeérisation rapide avec EPSON Scan

Utilisez EPSON Scan en mode autonome pour effectuer des numérisations
rapides. Lancez EPSON Scan depuis votre ordinateur ou en appuyant sur le
bouton Démarrer < du scanner :

m  Windows : Cliquez sur Démarrer > Programmes ou Tous les
programmes > EPSON Scan > EPSON Scan.

m  Mac OS X: Double-cliquez sur I'icone EPSON Scan dans le dossier
Applications.

m  Mac OS 8.6 2 9.x : Sélectionnez EPSON Scan dans le menu Apple®

Lécran ci-dessous s’affiche. Apres avoir sélectionné les parametres désirés, EPSON
Scan est lancé et numérise votre image.

£ Enregistrement des fichiers g] )
o Sélectionnez
s :
A I'emplacement
C:\Documents and SettingsiepsontMes documen de sauvega rde
Mo du fichier [Prefiz + 3-digit number] de votre fICh er.
Préfive img Muméro de début; | 001 |3
Nommez |
votre Fommat de limage
fichi Tvpe: BITMAP [* brp) w
Ichier. Détals | Sélectionnez un
type de fichier.
] Renommer tous les fichiers de méme nom
C| Iq uezsur Afficher cette baite de dialogue avant nouvelle numérization
OK pour Ouwiir un dossier image aprés la numérisation(E]
numériser. — ok | [ e | [ i)
Remarque :

Si vous utilisez Windows, il est possible d'attribuer d'autres applications (comme
Photoshop Elements ou ABBYY FineReader) au bouton Démarrer <& du scanner. Quand
vous appuyez sur le bouton Démarrer <, la boite de dialogue EPSON Scan s'ouvre ou la
numérisation est lancée automatiquement et I'image numérisée est acheminée vers
I'application. Consultez le Guide de référence électronique pour les directives.
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Résolution de problemes

Probléme

Solution

Un message d’erreur
saffiche quand vous
tentez de numériser

ou le scanner n'effectue
pas de numérisation.

Assurez-vous que le scanner est connecté a ['ordinateur,
q

que son cordon d’alimentation est bien branché dans une
prise de courant et que le scanner est sous tension.

Mettez le scanner hors tension, puis sous tension.

Assurez-vous que les deux verrous de transport sont en
position déverrouillée.

Le coin de la photo

nest pas numérisé.

Décalez la photo d’au moins 1,5 mm (0,06 po) des bords
supérieur et droit de la vitre d’exposition.

Impossible de
numériser des négatifs
ou des diapositives.

Assurez-vous que le cible du lecteur de transparents est
bien branché dans le scanner et que le cache pour
documents opaques est retiré. Si le cable du lecteur de
transparents n'est pas connecté au scanner, mettez
appareil hors tension, branchez le cible et remettez-le
sous tension.

Utilisez le mode Loisirs ou Professionnel plutdt que le
mode Auto. Assurez vous que le parametre Type de
document/Type de film correspond au type de document
numérisé : Film négatif couleur, Film négatif
monochrome ou Film positif couleur (pour les
diapositives et les transparents).

Vérifiez que la vitre d’exposition du scanner est propre et
que le support de films est positionné correctement.

Vous utilisez le lecteur
de transparents, et les
couleurs de la
prévisualisation du film
négatif semblent
incorrectes.

Vérifiez que vous avez bien sélectionné le paramétre Type

de document/Type de film approprié dans EPSON Scan.

Sile film n'est pas décoloré, assurez-vous que 'option
Restauration de la couleur nest pas sélectionnée.

Des lignes verticales
pales apparaissent sur
I'image numérisée.

g

La zone d’étalonnage du lecteur de transparents (le petit
rectangle de verre dans la partie supérieure de la vitre
d’exposition) peut étre souillée ou comporter de la
poussitre. Nettoyez la zone d’étalonnage avec un chiffon
non pelucheux.

Pour obtenir de I'aide supplémentaire, consultez le Guide de référence électronique.

Astuces et résolution de problemes
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Déclarations

Consignes de sécurité importantes

Lisez toutes ces directives et conservez-les pour pouvoir vous y reporter ultérieurement.
Observez les directives et les avertissements indiqués sur le scanner.

m  Installez le scanner suffisamment pres de 'ordinateur pour permettre le raccordement
facile du cable d’interface. Evitez de placer ou de ranger le scanner 4 extérieur, sur
une surface instable, & proximité d’eau ou d’une source de chaleur ou de poussi¢re
excessives, dans un endroit soumis a des chocs ou 4 des vibrations, 4 des températures
ou des taux d’humidité élevés ou sujet 2 la lumiére directe du soleil, & des éclairages
intenses ou a des changements brusques de température ou d’humidité. N’utilisez pas
le scanner lorsque vos mains sont humides.

m  Placez le scanner pres d’une prise de courant ot le cordon d’alimentation peut étre
débranché facilement.

m  Prévoyez suffisamment d’espace & l'arriere du scanner pour les cibles et un
dégagement suffisant au-dessus du scanner pour permettre d’ouvrir complétement le
capot.

m  Débranchez le scanner avant le nettoyage. Nettoyez I'appareil avec un chiffon humide
seulement. Nutilisez pas de produits de nettoyage liquide ou en aérosol.

m  Gardez le scanner hors de portée des enfants.
m  Utilisez uniquement le type d’alimentation indiqué sur Iétiquette du scanner.

m  Les cordons d’alimentation doivent étre protégés contre I'abrasion, les entailles, les
enroulements et les torsions. Placez les cordons de maniere 4 éviter tout dommage. Ne
posez pas d’objets sur le cordon et ne le placez pas de telle sorte que 'on puisse passer
ou marcher dessus. Veillez tout particuli¢rement a ce que les extrémités du cordon aux
points d’entrée et de sortie du transformateur restent bien droites.

m  Connectez tout le matériel a des prises d’alimentation mises 2 la terre. Evitez d’utiliser
des prises se trouvant sur le méme circuit qu’'un photocopieur ou qu’un systeme
d’aération qui s’éteint et se rallume  intervalles réguliers.

m  Nutilisez pas un cordon d’alimentation endommagé ou effiloché.

m  Sivous utilisez une rallonge avec le scanner, veillez 4 ce que I'intensité nominale totale
des dispositifs branchés sur la rallonge ne dépasse pas la capacité nominale totale de la
rallonge. Assurez-vous également que I'intensité nominale totale de tous les dispositifs
branchés dans la prise murale ne dépasse pas la capacité nominale de cette dernicre.
Ne surchargez pas les prises de courant.

m  Ne démontez ni ne modifiez jamais le scanner, le lecteur de transparents ou le cordon
d’alimentation.
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m  Nintroduisez aucun objet dans les ouvertures au risque de toucher des points de
haute tension ou de court-circuiter des pieces. Faites trés attention aux risques de
chocs électriques.

m  Lalampe du scanner contient du mercure. Consultez votre province ou localité pour
connaitre les réglements en vigueur concernant I'élimination ou le recyclage. Ne
mettez pas la lampe au rebut.

m  Sivous n’utilisez pas le scanner pendant de longues périodes, n’oubliez pas de le
débrancher de la prise de courant.

m  Débranchez le scanner et adressez-vous a un technicien agréé dans les cas suivants :

La fiche ou le cordon d’alimentation est endommagé; une substance liquide s’est
infiltrée dans le scanner; le scanner est tombé ou son boitier a été endommagg; le
scanner ne fonctionne pas correctement ou son rendement est en baisse. (Ne réglez
pas les commandes qui ne figurent pas dans ces directives de fonctionnement.)

Déclaration de conformité avec la FCC

Pour les utilisateurs aux Etats-Unis

A lissue des tests dont il a fait lobjet, cet appareil a été déclaré conforme aux normes des
appareils numériques de classe B conformément a la partie 15 de la réglementation FCC.
Ces normes sont destinées 4 assurer un niveau de protection adéquat contre les
interférences dans les installations résidentielles. Cet appareil produit, utilise et peut
émettre des fréquences radioélectriques. S’il n’est pas installé ou utilisé conformément aux
directives, il peut brouiller les ondes radio ou télévision. Toutefois, il est impossible de
garantir qu’aucune interférence ne se produira dans une installation particulitre. Si cet
équipement brouille la réception des ondes radio et télévision, ce que vous pouvez
déterminer en éteignant et en rallumant I'équipement, nous vous encourageons 4 prendre
I'une ou plusieurs des mesures correctives suivantes :

m  Réorientez ou déplacez 'antenne réceptrice.

»  Eloignez I'appareil du récepteur.

m  Branchez 'appareil sur une autre prise ou un autre circuit que celui du récepteur.

m  Demandez conseil aupres du revendeur de 'appareil ou d’un technicien radio/
télévision expérimenté.

AVERTISSEMENT : Le branchement d’un cable d’interface non blindé & ce matériel
entrainera 'annulation de ’homologation FCC de cet appareil et risque d’engendrer des
interférences dépassant les limites établies par la FCC pour ce matériel. Il incombe 4
T'utilisateur de se procurer et d’utiliser un cable d’interface blindé avec cet appareil. Si le
matériel est doté de plusieurs connecteurs d’interface, évitez de connecter des cibles a des
interfaces inutilisées. Toute modification non expressément autorisée par le fabricant peut
annuler la permission d’utilisation du matériel.

Déclarations
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Pour les utilisateurs au Canada

Cet appareil numérique de classe B respecte toutes les exigences du Réglement sur le
matériel brouilleur du Canada.

Déclaration de conformité

Selon la norme 47CFR, parties 2 et 15 régissant les ordinateurs personnels et périphériques de classe
B, et/ou les unités centrales et les dispositifs d’alimentation électrique utilisés avec les ordinateurs
personnels de classe B :

Nous : EPSON America, Inc.

Situés A : MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Téléphone : (562) 290-5254

Déclarons sous notre seule et unique responsabilité que le produit identifié dans la
présente est conforme 2 la norme 47CFR, parties 2 et 15 des regles FCC régissant les
dispositifs numériques de classe B. Chaque produit commercialisé est identique 4 'appareil
représentatif essayé et jugé conforme aux normes. Les dossiers tenus indiquent que
I'équipement produit se situe dans les limites acceptables, du fait de la production en
quantité et des essais réalisés sur une base statistique, en conformité avec le réglement
47CFR, alinéa 2.909. Le fonctionnement est soumis aux deux conditions suivantes : (1)
cet appareil ne doit pas causer de brouillage préjudiciable, et (2) cet appareil doit accepter
tout brouillage recu, y compris le brouillage pouvant provoquer un fonctionnement
indésirable.

Nom commercial : EPSON
Type de produit : ~ Scanner d’images
Modele : J131A
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Garantie limitée Epson America, Inc.

Ce qui est couvert : Epson America, Inc. (<EPSON») garantit au premier acheteur au détail
que le produit EPSON accompagnant la présente garantie limitée, s'il est acheté aux Erats-
Unis ou au Canada, est conforme aux spécifications du fabricant et sera exempt de défaut
de fabrication et de vice de matériau pour une période d’un (1) an a compter de la date
d’achat d’origine. Pour tout service au titre de la garantie, vous devez présenter la preuve de
la date d’achat d’origine.

Ce qu’EPSON feéra pour remédier aux problemes : Si votre produit EPSON se révele
défectueux pendant la période de garantie, veuillez apporter le produit dans son emballage
d’origine ou un emballage équivalent, accompagné d’une preuve de la date d’achat d’origine,
A votre revendeur EPSON ou au centre apres-vente EPSON. Cest & vous qu’il appartient de
régler tous les frais d’acheminement (expédition, assurance, délais de livraison) du produit a
latelier de réparation. EPSON peut, 4 son choix, réparer ou remplacer 'appareil défectueux
sur la base d’un échange, sans frais de pi¢ces ou de main-d’ceuvre. Lorsqu’une intervention
au titre de la garantie nécessite 'échange du produit ou d’une pitce, 'élément remplacé
devient la propriété ' EPSON. L'unité de remplacement pourra étre neuve ou remise & neuf
selon les normes de qualité ’EPSON et, au choix 'EPSON, pourra étre un autre modele
de méme type et qualité. La responsabilité EPSON pour le remplacement du produit
couvert ne pourra dépasser le prix d’achat au détail d’origine du produit. Les produits ou
pitces d’échange ou de remplacement sont couverts pour la période de garantie restante du
produit couvert par cette garantie limitée.

Ce qui n'est pas couvert par la garantie : Cette garantie ne s’applique pas aux produits remis &
neuf ou reconditionnés. Cette garantie ne s’applique qu’aux Etats-Unis et au Canada pour
I'utilisation normale du produit. Elle ne s’applique pas aux dommages subis par le produit
EPSON du fait de l'utilisation de pitces ou fournitures non fabriquées, distribuées ou
homologuées par EPSON. Cette garantie n’est pas transférable. Sont notamment exclus de
la garantie les pieces, composants ou périphériques fabriqués par des tiers et ajoutés au
produit EPSON apres son expédition par EPSON, comme par exemple des cartes,
microcircuits ou composants ajoutés par le revendeur. EPSON ne sera pas tenue d’effectuer
d’interventions au titre de la garantie lorsque 'étiquette ou le logo EPSON, le numéro de
série ou la plaque signalétique ont été enlevés de 'unité, ou si le produit n’est pas
correctement entretenu ou ne fonctionne pas correctement du fait d’une mauvaise
utilisation, d’une utilisation abusive, d’une installation incorrecte, d’une négligence,
d’avaries lors du transport, de dommages causés par un incendie, une inondation, la foudre,
une surtension électrique, des problemes de logiciel, une interaction avec des produits de
marque autre QU EPSON, ou d’une intervention effectuée par un tiers autre qu'un
réparateur EPSON agréé. Si une anomalie déclarée ne peut étre identifiée ou reproduite en
atelier, les frais engagés seront a votre charge.
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CE QUI PRECEDE CONSTITUE LA SEULE GARANTIE ET EXCLUT TOUTE
AUTRE GARANTIE, EXPRESSE OU IMPLICITE, Y COMPRIS, MAIS SANS 'Y
LIMITER, TOUTE GARANTIE IMPLICITE DE QUALITE MARCHANDE OU
D’APTITUDE A UNE FIN PARTICULIERE. CERTAINES LOIS N'AUTORISENT
PAS EXCLUSION DES GARANTIES IMPLICITES. SI CES LOIS SAPPLIQUENT
A VOUS, TOUTES LES GARANTIES EXPRESSES OU IMPLICITES SONT
LIMITEES A LA PERIODE DE GARANTIE DEFINIE CI-DESSUS. SAUF
DISPOSITIONS CONTRAIRES, TOUTE DECLARATION OU GARANTIE FAITE
PAR UNE AUTRE PERSONNE OU SOCIETE EST NULLE. EN CAS D’ECHEC
DES RECOURS SUSMENTIONNES, LA RESPONSABILITE COMPLETE
D’EPSON SE LIMITE A UN REMBOURSEMENT DU PRIX PAYE POUR LE
PRODUIT EPSON COUVERT PAR LA PRESENTE GARANTIE LIMITEE. SAUF
DISPOSITION CONTRAIRE DANS CETTE GARANTIE ECRITE, NI EPSON
AMERICA INC. NI SES FILIALES NE POURRONT ETRE TENUES
RESPONSABLES EN CAS DE PERTE, GENE OU DOMMAGES, Y COMPRIS LES
DOMMAGES DIRECTS, SPECIAUX, ACCESSOIRES OU INDIRECTS
DECOULANT DE L’UTILISATION OU DE L’'IMPOSSIBILITE D’UTILISATION
DU PRODUIT EPSON, QUE CE SOIT A LA SUITE DU NON-RESPECT DE LA
GARANTIE OU D’UNE AUTRE THEORIE JURIDIQUE.

Au Canada, les garanties englobent les garanties et les conditions.

Certains territoires n’autorisant pas les limitations qui s’appliquent 2 la durée d’une garantie
implicite, et d’autres n’autorisant pas 'exclusion ou la limitation des dommages, il est
possible que les limitations et exclusions ci-dessus ne s’appliquent pas & vous. Cette garantie
vous donne des droits juridiques spéciaux qui sont susceptibles de varier d’un territoire &
lautre.

Pour obtenir les coordonnées du revendeur agréé EPSON ou du centre apres-vente EPSON
le plus pres de vous, appelez le : (800) 922-8911 ou écrivez a : Epson America, Inc., P.O.
Box 93012, Long Beach, CA 90809-3012.
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Avis sur les droits d’auteur

Tous droits réservés. Il est interdit de reproduire, de conserver dans un systéme central ou de
transmettre le contenu de cette publication sous quelque forme et par quelque moyen que ce soit —
reproduction électronique ou mécanique, photocopie, enregistrement ou autre — sans la permission
écrite préalable de SEIKO EPSON CORPORATION. L’information contenue dans la présente ne
peut étre utilisée qu'avec ce produit EPSON. EPSON décline toute responsabilité en cas
d’utilisation de cette information avec d’autres appareils.

Ni SEIKO EPSON CORPORATION ni ses filiales ne sont responsables vis-a-vis de 'acheteur de ce
produit ou de tierces parties en cas de dommages, de pertes, de frais ou de dépenses engagées par
Iacheteur ou les tierces parties par suite d’un accident ou d’une mauvaise utilisation de ce produit ou
de modifications, réparations ou altérations non autorisées de ce produit ou (sauf pour les Frats-

Unis) du non-respect des directives de fonctionnement et d’entretien fournies par SEIKO EPSON
CORPORATION.

SEIKO EPSON CORPORATION décline toute responsabilité en cas de dommages ou de

problémes découlant de 'utilisation d’options ou de produits consommables autres que les produits
désignés comme produits d’origine EPSON ou comme produits approuvés EPSON par SEIKO
EPSON CORPORATION.

Utilisation responsable du matériel protégé
p proteg
par les lois sur les droits d’auteur

Les appareils photo numériques, les scanners et les imprimantes  jet d’encre, comme les
photocopieurs et les appareils photo conventionnels, peuvent servir  la reproduction ou &
I'impression non appropriée de matériel protégé par les lois sur les droits d’auteur. Dans certains
pays, la loi permet une reproduction limitée de matériel protégé dans certaines circonstances, mais
ces dernieres sont parfois moins étendues que le croient certaines personnes. EPSON encourage les
utilisateurs d’appareils photo numériques, de scanners et d’imprimantes  jet d’encre 2 faire preuve
de responsabilité et a respecter les lois sur les droits d’auteur.

Marques de commerce
EPSON est une marque déposée de SEIKO EPSON CORPORATION. EPSON Perfection est une

marque déposée et Easy Photo Fix est une marque de commerce d’Epson America, Inc.
DIGITAL ICE est une marque de commerce de Kodak.

Avis général : Les autres noms de produit qui figurent dans le présent document ne sont cités qu’a
tire d’identification et peuvent étre des marques de commerce de leurs propriéaires respectifs.
EPSON renonce a tous les droits associés a ces marques.
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